JDSU Test Equipment Training
In support of AT&T requirements

Effective 9/1/2014
Transmission Equipment Installation Procedures

Michael L Yeilding - AT&T – Principal Product Development Engineer
Neven Jambresic - JDSU – Product Line Manager
Agenda

- Inspection & Testing Fundamentals
  - Reference Methods
- Equipment Setup
- The Measurements/ Test Procedure
  - Documentation and Report
Inspection & Testing Fundamentals
What Makes a BAD Fiber Connection?

Today’s connector design and production techniques have eliminated most of the challenges to achieving Core Alignment and Physical Contact.

What remains challenging is maintaining a Pristine End-face. As a result, CONTAMINATION is the #1 source of troubleshooting in optical networks.

- A single particle mated into the core of a fiber can cause significant back reflection, insertion loss and even equipment damage.
Illustration of Particle Migration

- Each time the connectors are mated, particles around the core are displaced, causing them to migrate and spread across the fiber surface.
- Particles larger than 5 µm usually explode and multiply upon mating.
- Large particles can create barriers (“air gaps”) that prevent physical contact.
- Particles less than 5 µm tend to embed into the fiber surface, creating pits and chips.
PROACTIVE INSPECTION:
Visually inspecting fiber connectors at every stage of handling *BEFORE* mating them.

*Connectors are much easier to clean prior to mating, before*

Fiber *AFTER* Cleaning

REACTIVE INSPECTION:
Visually inspecting fiber connectors *AFTER* a problem is discovered, typically during troubleshooting.

*By this time, connectors and other equipment may have suffered permanent damage.*

Fiber *AFTER* Mating and Numerous Cleanings
Fiber Contamination and Its Affect on Signal Performance

Clean Connection vs. Dirty Connection

This OTDR trace illustrates a significant decrease in signal performance when dirty connectors are mated.

The typical budgeted loss for a mated connector pair is 0.5dB

This dirty connector caused ~4.9dB which is a 68% power drop
Follow this simple “INSPECT BEFORE YOU CONNECT” process to ensure fiber end faces are clean prior to mating connectors.
Reference Methods and Insertion Loss Testing
Setting Reference – Two options:

- 1 Fiber Reference

- Connect the OLTS together w/reference jumper – reference power meter (set to 0dB)

- Disconnect the fiber at the power meter. Connect a test jumper to the power meter. Add couplers (channel testing) or connect to bulkhead (link testing) and connect to fiber system under test.

OLTS = Optical Loss Test Set. Typically has Light Source and Power Meter at both ends. Simplex shown for clarity.
Summary of Reference Methods

- Difference is the number of bulkhead (coupler) connections referenced out of the loss measurement.

Always check your reference!
Connect test jumpers together and measure loss
Ensure no “gainers”
Save result for proof of good reference
Measuring Insertion Loss

Single Direction Insertion Loss Measurement with a Source and Power Meter

Reference first!

Light Source → Power Meter
Reference Measurement

Light Source → Power Meter
Insertion Loss Measurement

-6dBm
Zero Ref
0.00 dB r

-1.5dB

INJURY TO EYES CAUSED BY INVISIBLE LASER RADIATION
Optical Systems operate with invisible laser radiation. Laser radiation can cause irreparable injuries to the human eyes. Never look into the end of an exposed fiber or into an open optical connector. ATT-770-000-013
The Measurements
All test jumper end faces shall be inspected (and cleaned if necessary) prior to performing any loss testing per ATT-TP-76461.

Following the fiber end face inspection and loss measurement test the results shall be recorded on the New Fiber Inspection & Grading Form. This information is required to be loaded into EJF under the following file name FBR_INSPI.
Acceptable loss is based on several factors:
- Number of connections
- Number of splices
- Loss per Km (at specific wavelengths)

Example **allowable** losses (TIA)
- Loss per connection = 0.75 dB
- Loss per splice= 0.3dB
- Loss per Km (slope)
  - MM 850nm = 3.5 dB
  - SM 1310 nm = 1.0 dB
Testing Requirements

1. If jumper loss reading is greater than 0.80dB, the installation supplier shall follow cleaning procedures in ATT-TP-76461 and retest.

2. If the loss is greater than 0.80dB, the jumper is not acceptable and shall be replaced.

3. If testing is done between two FOT panels, 0.75 dB is added to the maximum allowable loss the 0.75dB takes into account the loss in the (2) bulk head connectors. In this case the loss should be less than 1.55 dB.

Reference ANSI/TIA/EIA 568-B.3 - Optical Fiber Cabling Components Standards

The maximum loss allowed on a fiber cable (inside only) is calculated as follows: 0.75 dB (2) Connectors (Mated Pair) + 1.0 dB/Km of fiber cable + 0.3 dB per fusion or mechanical splice
One Fiber Reference
2 connections (default for one fiber reference)
No splices
300 meters of MMF
Test Limit at 850nm:
• 0.75 dB per connector 1.5dB
• 300 meters (3.5 dB per km) 1.05dB
• Total 2.55 dB

SM Fiber should be tested with 1310nm
MM Fiber should be tested with 850nm
Equipment Set up

- OLP82 Fiber Overview
- Key Features & Functions
- Controls
- Operation
- Exporting to FiberChekPRO
- Using FiberChekPRO

**CAUTION:**
Inspection should ALWAYS precede cleaning or mating of optical connectors to prevent damage or contamination of the connectors.

**IMPORTANT:**
All Inspection Scopes contained in this document are Video type scopes or indirect image converters as defined by ATT-770-000-013. This document does not support the use of any Non-video type or direct viewing Inspection Scope.
Controls

Connector Interface

3.5" Touch Screen

Control Panel

LED Indicators

OPM
Universal 2.5 or 1.25mm

Patch Cord Microscope (PCM)

FMAE adapters

Test Head Cover

Battery Life

Graphic Interface

Input Ports

PCM controls (focus, test, magnification)

Ethernet
(OLP-87 only)

Power

1x Micro USB

2x USB2
Control Panel

**HOME** – Press to go to the home screen

**MENU** – Press to open a menu

**BACK** – Press to go back one step

**INPUT SELECT KEY (ISK)** – Press for fast toggling between devices

**POWER** – Press to turn the instrument ON and OFF

**ARROW KEYS**
- Press to navigate through menu items
- Press to change values in the menus

**CENTER KEY**
- Press to confirm the selection

**SAVE** – Press to save results

**LOW BATTERY** – Glows Red when battery is low

**TEST IN PROCESS** – Glows RED when a test is running in the background

**CHARGE** – Glows AMBER when battery is charging; if the power is OFF, charging will continue with no LED indicator

**INPUT SELECT KEY**
- Guides users through a proper test workflow.
- Provides simple step-by-step guidance to users with a repeatable, easy to follow process
- Ensures that the job is done right the first time.
- Drives the user’s behavior

| 1. | Press 🔄 from the Home Screen 🔄 switches to PCM Inspection (or the next available application) |
| 2. | Press 🔄 from an active application 🔄 switches to the next available application as follows*:

* Each application will only appear if it is available on the device, either on-board or via USB connection.
Export stored data to PC

- Connect via micro USB-to-USB2 cable (included)
- Import data to PC with included software
  - **OLP-82**: Includes FiberChekPRO V1.5

Upgrade firmware

- Install the AT&T V1.5 of the FCPRO
  - [http://fcpro.updatemyunit.net/](http://fcpro.updatemyunit.net/)
- Connect OLP82 via micro USB-to-USB2 cable
- In OLP82 setup select firmware (click update)
Home Screen Display

**OLP-82P**

**INSPECT**
Inspect and analyze fiber end faces, select acceptance criteria, detect scratches and defects, view PASS/FAIL results, save and recall data.

- **Inspect (PCM)** - Activates the integrated Patch Cord Microscope (PCM) if available on the device (ex: OLP-82P)

- **Inspect (Probe)** - Activates the handheld P5000i Digital Probe microscope (if connected to one of the USB ports)

**TEST**
View power measurement and PASS/FAIL results, edit acceptance criteria, save and recall results.

- **Optical Power Meter (OPM)** - Activates the on-board OPM on OLP-82
Operation: General Setup

- **System Settings**
  - Brightness, Date, Time, Time Format, Auto Off, etc.
  - Access from Home screen menu

- **Microscope Settings**
  - Auto Center, Focus Quality Meter, Device Button Function (Capture/Test)
  - Access from Microscope application

- **User Information***
  - Configurable in device:
    - **Company**, **Location**, **Job ID**, **Operator**,
    - **Rack**, **Panel/Shelf**, **Tray/Slot**, **Port**.
  - Access from Home screen menu & application
Operation: Inspection

- **Select Acceptance Criteria**
  1. Open the application (PCM or Probe)
  2. Press MENU
  3. Select PROFILE (SM, Post Polish)
  4. Select TIP

- **Inspect & Certify connector end faces**
  1. Open the application (PCM or Probe)
  2. Focus the image
  3. Press the TEST button
  4. Press the SAVE button

- **View stored results**
  1. Choose RECALL IMAGE (from Application or Home Screen)
  2. Select all images you want to view
  3. Press MENU / VIEW
Operation: Optical Power Meter

- **Measure & Store OPM readings**
  - Select desired wavelengths (λ) – SM 1310nm & MM 850nm
  - Select Relative (dB) power level
  - Easily set reference measurements
  - Save readings (up to 10,000)

- **View stored results on the device**
  - Choose REVIEW OPM DATA (from Application or Home Screen)
  - All saved results will be displayed
    - OPM reading, time, date, wavelength & tone

- **Customizable functions**
  - Customize the list of wavelengths you want available
FCPRO - Easy to Use Interface

**Microscope Settings**
- Simplified Microscope, Tip and Profile Setting
- AutoCenter

**Image Controls**
- Magnification High/Low
- AutoCenter

**Results & Reporting**
- Clear PASS/FAIL Results
- Click for details of result
- Focus Quality Meter
- Live, Test and Save

**Optical Power Meter**
- Accepts JDSU USB Power Meters
- Integrates with Report

**Dedicated Tabs**
- Inspection/OPM/Import
- Only appear if relevant
Images and analysis data obtained from FiberChekPRO can be archived in several different forms.

**PDF**
- Compress analyzed data into smaller file size

**Layout - Standard or Consolidated**
- Standard – Save one result per report
- Consolidated – Save many results in one report

**File Naming**
- Rack, Panel/Shelf, Tray/Slot, Port #
The Optical Power Meter menu allows you to configure options when using a USB-enabled JDSU OPM, such as the FI-series or MP-series. Checking the box next to Link OPM readings with fiber analysis allows you to associate power meter readings with a fiber analysis.
Tip Settings

- **Standard Tips (with BAP1)**
  This calibration setting is recommended when using standard tips with the FBPP-BAP1 barrel assembly (included and factory assembled to P5000 probe).

- **Simplex Long Reach (-L) Tips**
  This calibration setting is recommended when using long reach inspection tips.
The Test Procedure
Test Procedure Steps

Equipment required at:

**Location A**: Fiber Inspection Microscope, Cleaning equipment and Optical Power Meter

**Location Z**: Fiber Inspection Microscope, Cleaning equipment and Optical Light Source
Test Procedure Steps-

Inspect & Clean Bulkhead
1. Select the appropriate bulkhead inspection tip that corresponds to the connector type and install onto probe.
2. Insert the scope into the bulkhead to inspect.
3. Determine whether clean or dirty.
   1. If clean, do not touch it and CONNECT.
   2. If dirty, and cleaning is required, CLEAN.

Inspect & Clean Patch Cord with PCM or Probe
1. Select the appropriate patch cord adapter that corresponds to the connector type and install onto PCM.
2. Attach the patch cord to the PCM or Probe.
3. Determine whether clean or dirty.
   1. If clean, do not touch it and CONNECT.
   2. If dirty, and cleaning is required, CLEAN.

Note: Wet – Dry Clean
If the Dry Cleaning method doesn’t clean connector after 3 cleaning attempts, proceed with the Wet-Dry Cleaning.
Location A – Equipment needed: Inspection microscope, cleaning equipment, Optical power meter

• Set up Inspection microscope and reference optical light source and optical power meter. (see set up instructions)
• Inspect, clean (if needed) fiber trunk cable.
• Document inspection test result
  • Enter note image as [location]- Fiber [channel #]A
  • Example: “Fiber 1A”
  • Before saving first inspection result go to MENU, MORE and CREATE NEW GROUP
• Type [channel #] on base Fiber name and save test result. Example: “Fiber 1A”, “Fiber2A”, “Fiber3A”, etc…. to “Fiber 72A”.
• Insert test jumpers into the adapter for fiber under test
• Start the optical power meter; select the correct wavelength (the same wavelength as OLS on the Location Z).
• Record power level in dB by clicking “Save”
• Repeat the same procedure for each fiber in the fiber trunk.
  • Inspect the test lead and next fiber port after each test
Test Procedure Steps-

**Location Z** – Equipment needed: Inspection microscope, cleaning equipment, Optical Light Source

- Set up Inspection microscope and reference optical light source and optical power meter. (see set up instructions)
- Inspect, clean (if needed) fiber trunk cable.
- Document inspection test result
  - Enter note image as - Fiber [channel #]Z
  - Example: “– Fiber 1Z”
- Type [channel #Z ] on base Fiber name and save test result. Example: “Fiber 1Z”, “Fiber2Z”, “Fiber3Z”, etc…. to “Fiber 72Z”.

- Insert test jumpers into the adapter on fiber under test
- Start the optical light source, select the correct wavelength (MM 850nm or SM 1310nm) and start the laser when Location Z is ready to test.
- Repeat the same procedure for each fiber in the fiber trunk.
  - Inspect the test lead and next fiber port after each test.
Importing Data with FiberChekPRO (V1.5)

1) Connect the compatible device with stored data to the PC and select the **Import tab**.
2) Select the desired Import Location from the dialog box marked **Import Location**.
3) Click the **IMPORT ALL** button.

*NOTE: This tab will only appear when a compatible device with stored data is connected.*

This gives a summary of all the Stored Data on the connected device:

- **Inspection Reports**: Displays the count of all Inspection reports with PASS/FAIL analysis
- **Captured Images**: Displays the count of images that were captured and saved specifically as images
- **OPM Measurements**: Displays the total count of OPM measurements saved on the device
# Fiber Connector Inspection & Grading Test Record Form

**Fiber Information**
- **File Name:** Fiber 1 A Location.pdf
- **Fiber Type:** Simplex
- **Job ID:** 12344321 (TEO #)
- **Rack:** 121.02
- **Panel/Shelf:** 1
- **Tray/Slot:** 5
- **Port:** 1/8-0
- **TX or RX:** TX

**Profile Name:** SM UPC (IEC 61300-3-35)

<table>
<thead>
<tr>
<th>Zone A (0 - 20)</th>
<th>Zone B (20 - 120)</th>
<th>Zone C (120 - 130)</th>
<th>Zone D (130 - 250)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PASS</td>
<td>PASS</td>
<td>PASS</td>
<td>PASS</td>
</tr>
</tbody>
</table>

**Measurement**
- **Wavelength:** 850 1300
- **Frequency:** 0.1 nm

**Low Magnification**

**High Magnification**

---

© 2014 JDS Uniphase Corporation
Instructions to embed .pdf files into the table:

- Select the field in the table in which you would like to embed the .pdf file.
- Click on the “Insert” tab in the menu toolbar
- In the Text group, click on “Object”
- In the Object dialog window, click on the “Create from File” tab
- Check the “display as icon” checkbox
- Click on “browse…” and browse to the file you want to embed
- Click on “Insert”, which should take you back to the “Create from File” tab
- Click on “OK”. The file should be embedded in the table.
## Fiber Connector Inspection Test Record Form Example

All fiber inspection test results shall be documented on the Fiber Connector Inspection Test Record form.

**Note:** Form can be found on the Technical Publications and NEBS website at: [https://ebiznet.sbc.com/sbcnebs/](https://ebiznet.sbc.com/sbcnebs/)

<table>
<thead>
<tr>
<th>Fiber #</th>
<th>1st Inspection P/F</th>
<th>“A” End RR or Unique ID</th>
<th>“Z” End RR or Unique ID</th>
<th>1st dry clean P/F</th>
<th>2nd dry clean P/F</th>
<th>3rd dry clean P/F</th>
<th>1st wet&amp;dry clean P/F</th>
<th>2nd wet&amp;dry clean P/F</th>
<th>“A” End FiberCheck Report w/OPM result</th>
<th>“Z” End FiberCheck Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>P</td>
<td>121.02 SH.1 SL.5 PT.1/8 TX</td>
<td>120.06 PNL.8 JK.85 TX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
</tr>
<tr>
<td>2</td>
<td>F</td>
<td>121.02 SH.1 SL.5 PT.1/8 RX</td>
<td>120.06 PNL.8 JK.86 RX</td>
<td>F</td>
<td>F</td>
<td>P</td>
<td></td>
<td></td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
</tr>
<tr>
<td>3</td>
<td>P</td>
<td>121.02 SH.1 SL.5 PT.1/9 TX</td>
<td>120.06 PNL.8 JK.87 TX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
</tr>
<tr>
<td>4</td>
<td>P</td>
<td>121.02 SH.1 SL.5 PT.1/9 RX</td>
<td>120.06 PNL.8 JK.88 RX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
</tr>
<tr>
<td>5</td>
<td>F</td>
<td>121.02 SH.1 SL.5 PT.2/0 TX</td>
<td>120.06 PNL.8 JK.89 TX</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>P</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
</tr>
<tr>
<td>6</td>
<td>P</td>
<td>121.02 SH.1 SL.5 PT.2/0 RX</td>
<td>120.06 PNL.8 JK.90 RX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
</tr>
<tr>
<td>7</td>
<td>F</td>
<td>121.02 SH.1 SL.5 PT.2/1 TX</td>
<td>120.06 PNL.8 JK.91 TX</td>
<td>F</td>
<td>P</td>
<td></td>
<td></td>
<td></td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
<td>C:\Users\my1515\Documents\1Mike\JDSU\Test Reports</td>
</tr>
</tbody>
</table>
### Key Contacts

<table>
<thead>
<tr>
<th>Name</th>
<th>Contact Info</th>
<th>Role/Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Todd Watkins</td>
<td><a href="mailto:Todd.Watkins@jdsu.com">Todd.Watkins@jdsu.com</a> (972) 692-3781</td>
<td>Equipment Information</td>
</tr>
<tr>
<td>JDSU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Neven Jambresic</td>
<td><a href="mailto:Neven.Jambresic@jdsu.com">Neven.Jambresic@jdsu.com</a> (425) 368-2216</td>
<td>Equipment Information</td>
</tr>
<tr>
<td>JDSU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JDSU - Technical Assistance Center</td>
<td><a href="mailto:tac@jdsu.com">tac@jdsu.com</a> 855-275-5378 option 3,1,1</td>
<td>Technical Support</td>
</tr>
<tr>
<td>JDSU - Anjanette Robinson</td>
<td><a href="mailto:Anjanette.Robinson@jdsu.com">Anjanette.Robinson@jdsu.com</a> (240) 404-1541</td>
<td>Equipment Ordering</td>
</tr>
<tr>
<td>TESSCO – Steve Bennet</td>
<td><a href="mailto:bennetts@tessco.com">bennetts@tessco.com</a> (410) 790-7347</td>
<td>Equipment Ordering</td>
</tr>
<tr>
<td>Electro Rent - Cory Jenson</td>
<td><a href="mailto:cjenson@electrorent.com">cjenson@electrorent.com</a> (800) 688-1111</td>
<td>Equipment Rental</td>
</tr>
<tr>
<td>TRS-Rentelco – James Ranstrom</td>
<td><a href="mailto:James.Ranstrom@trs-rentelco.com">James.Ranstrom@trs-rentelco.com</a> (800) 874-7123</td>
<td>Equipment Rental</td>
</tr>
</tbody>
</table>
Online Training Materials

- **Training Webinar:**
  - Video Installation Testing Requirements

- **SmartClass Fiber**
  - Video: OLP-82P Setup Procedures
  - Video: OLP-82P Test Workflow

- **FiberChekMOBILE**
  - Video: How it works